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Attention!Attention!

Federal Communications Commission (FCC) Compliance 
Notice:
Radio Frequency Notice

NOTE:  This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These 
limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment 
in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense. 

This is a Class A product. In a domestic environment, 
this product may cause radio interference, in which case, 
the user may be required to take appropriate measures.

This equipment must be installed and wired properly in order to assure 
compliance with FCC regulations.

Caution!  Any modifications not expressly approved in writing by 
Wheatstone could void the user's authority to operate this equipment. 
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Adding The LIO-48 To The Peripheral Devices* Tab

In order to utilize all the features of the LIO‑48 Multiple 
Port Logic I/O BLADE the device must be added to the System 
 Peripheral  Devices tab in the Wheatstone WheatNet‑IP  Navigator 
program (aka the  Navigator GUI). This sheet shows you the 
 basics of that  procedure. Refer to the WheatNet‑IP Audio Over 
IP Network Technical Manual for additional details.

You will need to know the IP address of the device being 
added, so you will want to find that out before you start.

Launch the Navigator GUI and make sure that System 0 is 
selected in the System pane. You will see something like this:

Now select the Peripheral Devices tab.

Click the Add button to bring up the Add Peripheral 
Device dialog:

Type in a convenient Name and insert the IP  Address 
of the device being added. Leave the TCP Port at the 
default setting of 60021. From the Host BLADE drop 
down select the BLADE that you want to associate the 
Peripheral device with. Click Ok.

This completes the process of adding the device to 
the Peripheral Devices tab. The added device should 
show up in the System pane under the BLADE  you 
added it to. If it does not show up, or if it shows up but 
has a yellow question mark on it, then there is either a 
network issue that needs attention, or the device is not 
connected to the network at all, or one or more steps have been omitted or done  incorrectly 
in the configuration process.

* In previous Navigator GUI versions this was the System 3rd Party Devices tab.



page  Contents – 1LIO-48 / May 2013

C O N T E N T S

LIO-48 Technical Manual

 Chapter 1 - General Information

Table of Contents

Introduction ....................................................................................1-2

Rack Mounting ...............................................................................1-2

Installation Tips .............................................................................1-2

Energizing ......................................................................................1-3

A Word About Nomenclature .......................................................1-3

Model LIO-48 Multiple Port Logic I/O BLADE .............................1-4

Network Switches ..........................................................................1-5

CAT-5e Wiring ................................................................................1-5

Software Tools ...............................................................................1-5

Logic Ports Connections ..............................................................1-6
Logic I/O “A” RJ-45 ....................................................................................................1-6

Logic I/O “1-24” DB-25 ..............................................................................................1-6

+5VDC Logic DB-9 .....................................................................................................1-7

Simplified BLADE Logic I/O ..........................................................1-8
Input Logic .................................................................................................................1-8

Output Logic ...............................................................................................................1-8

LIO-48 BLADE - Input/Output Pinout Drawing ............................1-9

First Time Power Up ......................................................................2-2

Front Panel Controls .....................................................................2-2

Basic Network Settings .................................................................2-2

Making The Basic Network Settings ............................................2-3

Regarding The LIO-48 As Part Of A System ...............................2-4

BLADE Status Information ...........................................................2-4

Logic Testing – LOGIC METER ARRAY ......................................2-4

Logic Testing – Drilling Deeper ....................................................2-4

Front Panel Menu Diagram ...........................................................2-7

 Chapter 2 - Front Panel Operation



page  Contents – 2LIO-48 / May 2013

C O N T E N T S

Software Basics .............................................................................3-2

Razor Setup Tool ...........................................................................3-2

Razor Setup Tool – First Launch .................................................3-2

Adding A Device To The Devices Panel ......................................3-3

Discovering The System ...............................................................3-4

The LIO-48 Is A 3rd Party Device .................................................3-5

Programming The LIO-48 ..............................................................4-2

Wiring Switches And LEDs To The Logic Ports .........................4-2

Notes Regarding The Examples ...................................................4-2

Example 1 – Toggling An Indicator LED Remotely ....................4-2
Overview of Example 1 ...............................................................................................4-2

Program Logic On The Remote BLADE .....................................................................4-3

Program Logic On The LIO-48 ...................................................................................4-3

Test Example 1 ...........................................................................................................4-4

Multiple Indicators ......................................................................................................4-4

Program More Logic On The Remote BLADE ............................................................4-5

Testing The Modified Example ...................................................................................4-5

Beyond Example 1 .....................................................................................................4-5

Example 2 – Controlling A Control Surface Channel .................4-5
Overview of Example 2 ...............................................................................................4-5

Connecting The GP-4 To The LIO-48 .........................................................................4-5

Program Logic On The Remote BLADE .....................................................................4-6

Test Example 2 ...........................................................................................................4-8

Beyond Example 2 .....................................................................................................4-8

What Else can I Do? ......................................................................5-2

The File Menu .................................................................................5-2
Set Password... ..........................................................................................................5-2

Exit ..............................................................................................................................5-2

The View Menu ...............................................................................5-2
Devices .......................................................................................................................5-2

System Info ................................................................................................................5-3

Stylized .......................................................................................................................5-3

The WheatNet-IP System Menu ....................................................5-3
File Open... .................................................................................................................5-3

File Save... ..................................................................................................................5-3

System Scan... ...........................................................................................................5-3

 Chapter 3 - The Software Tools And Basic LIO-48 Setup

 Chapter 4 - Drilling Deeper – Programming The LIO-48

 Chapter 5 - Additional Razor Setup Tool Details



page  Contents – 3LIO-48 / May 2013

C O N T E N T S

The Hardware Menu ......................................................................5-3
Add New Device... ......................................................................................................5-3

Edit “<device name>”... .............................................................................................5-3

Remove “<device name>”...... ...................................................................................5-3

Assign IP Address... ...................................................................................................5-4

Version... .....................................................................................................................5-5

Update... .....................................................................................................................5-5

Reboot... .....................................................................................................................5-5

The Help Menu ...............................................................................5-5
About... .......................................................................................................................5-5

The Main Area Controls ................................................................5-5
Add... ..........................................................................................................................5-5

Edit... ..........................................................................................................................5-5

Delete .........................................................................................................................5-6

Apply ..........................................................................................................................5-6

Cancel ........................................................................................................................5-6

The Devices Panel Controls .........................................................5-6
Add... ..........................................................................................................................5-6

Edit... ..........................................................................................................................5-6

Remove ......................................................................................................................5-6

Online .........................................................................................................................5-6



page 1 - 1LIO-48 / May 2013

G E N E R A L  I N F O R M A T I O N

General Information

 Chapter Contents

Introduction ....................................................................................1-2

Rack Mounting ...............................................................................1-2

Installation Tips .............................................................................1-2

Energizing ......................................................................................1-3

A Word About Nomenclature .......................................................1-3

Model LIO-48 Multiple Port Logic I/O BLADE .............................1-4

Network Switches ..........................................................................1-5

CAT-5e Wiring ................................................................................1-5

Software Tools ...............................................................................1-5

Logic Ports Connections ..............................................................1-6
Logic I/O “A” RJ-45 ....................................................................................................1-6

Logic I/O “1-24” DB-25 ..............................................................................................1-6

+5VDC Logic DB-9 .....................................................................................................1-7

Simplified BLADE Logic I/O ..........................................................1-8
Input Logic .................................................................................................................1-8

Output Logic ...............................................................................................................1-8

LIO-48 BLADE - Input/Output Pinout Drawing ............................1-9



page 1 - 2LIO-48 / May 2013

G E N E R A L  I N F O R M A T I O N

General Information
Introduction

Congratulation on acquiring the Wheatstone LIO-48 Multiple Port Logic I/O BLADE. 
This exciting new addition to the WheatNet-IP Intelligent Network is a high-density logic 
BLADE that can handle all those new conditional logic functions needed for today’s busy 
studios. The LIO‑48 provides 48 universal logic I/O ports, each individually configurable. 
A logic I/O meter lets you drill down and see the information for each of the 48 ports. 
Broadcasters have been asking for more logic ports for new logic-intensive shows and 
applications, and the LIO-48 now offers this capability in one convenient BLADE add-on.

Rack Mounting
The LIO-48 is designed to be mounted in an industry standard 19" equipment rack, and 

requires one rack unit (1.75 inches) of vertical space. The LIO-48 BLADE has a depth of 
9‑1/2" behind the rack rails (including chassis connectors). An additional five inches of 
space is required for wiring cables to pass through. The chassis has a width of 17-3/8". 
Space needed in front of the rack rails is 3/4". Ideally, four screws should be used to mount 
the unit. If only two screws are being used they must be used in the bottom holes in order 
to provide proper support.   

The LIO-48 has vertical slots positioned in the side panels for venting. Make sure your 
installation does not obstruct these slots. There is no fan inside the LIO-48 because its 
power consumption is low enough to not require one.

The LIO-48 may be mounted between other devices in the equipment rack and in ac-
cordance with good engineering practice should not be mounted directly above devices that 
generate significant amounts of heat. If such a location is unavoidable then it is advisable to 
utilize an extra 1RU blank rack panel between the WheatNet-IP and devices immediately 
above and/or below it.

WARNING! Under no circumstances should the LIO‑48 unit be opened! The unit 
contains high voltage circuits that are hazardous and potentially harmful. The unit 
has no user‑serviceable parts inside! If you have a problem the unit must be returned 
to Wheatstone Corporation for repair. 

Installation Tips
• Place any surge protection circuits as close as possible to the LIO‑48 or other device 

being protected. 
• Establish a low impedance common ground in your facility and try to route all grounds 

to that point.
• Choose the best power conditioning / UPS units that you can afford and suitable for 

your equipment – focus on the features and options you need. The better UPS prod-
ucts can prevent thousands of dollars in equipment damage – some even come with 
an external equipment damage warranty.
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Energizing
Once it has been installed in the rack, the LIO-48 may be energized by connecting 

the factory supplied power cord to a source of AC power. The AC line input voltage 
is permitted to be between 90 and 260VAC, 50 or 60Hz. Power consumption is under 
100VA. 

Aggressive AC input filtering is utilized at the AC input of the LIO‑48; however, 
it is always advisable to use external surge protection and/or an uninterruptible power 
supply (UPS), especially where AC power quality is questionable, such as at a remote 
transmitter site. 

Power conditioning, surge suppression, and even power backup devices are wise in-
vestments when using sensitive modern electronic devices that use an internal computer. 

Use of a UPS (uninterruptible power supply) is a good idea and will protect the 
LIO-48 from short duration power interruptions which may cause it to reboot. 

A Word About Nomenclature
Throughout this manual references are made to “BLADEs,” “sources,” “destina-

tions,” and other terms whose meanings may not be instantly understood by everyone. 
Let’s take a moment to clarify some terms.

1. BLADE. In the WheatNet-IP system a “BLADE” is taken to mean an individual 
member of a WheatNet‑IP system; any device that has a unique BLADE ID. It com-
monly refers to an individual input/output rackmount unit, but a more complete defini-
tion would include any network connected PC running a WheatNet-IP driver as well, 
including Automation servers and even the Program Director’s PC if they are running 
the WheatNet-IP driver to listen to audio streams. Conversely, any PC that is running 
the WheatNet-IP Navigator GUI program or using a browser for interfacing to the built 
in web servers on BLADEs is not a BLADE itself. Only those devices that can transmit 
and/or receive WheatNet-IP audio streams are “BLADEs.” The one exception to this 
last statement is the LIO-48, which does not have audio inputs or outputs, but is still 
termed a BLADE.

2. Source. A source is any audio signal in the WheatNet-IP system that is uniquely 
generated. Any WheatNet-IP signal that is created by accepting and packetizing an input 
is a source, as is any signal generated within the system. Source signals may be audio, 
logic, or both. A logic source might be  a logic port triggered by an external switch. 
We generally avoid using the term “input” to describe WheatNet-IP signals because 
the term can be misleading. One would easily understand that an external audio input 
jack could be an “input” or “source,” but less obvious is the fact that an audio mix bus 
output is also a WheatNet-IP source because it is generating a unique signal (the mix) 
and making it available to stream throughout the system. Likewise, PCs streaming audio 
from a file via the WheatNet‑IP driver can clearly be seen as a “source.”

3. Destination. A destination is the opposite of a source. It is a signal that can accept 
any WheatNet-IP stream. A destination can take the received WheatNet-IP stream and 
convert it to a physical analog or digital output, or, in the case of a PC, a virtual output 
that subsequent PC application programs can convert to an audio output at the PC’s 
speakers, or lay down as an audio track on the hard disc. Destinations can be audio, logic, 
or both. A logic destination might be a logic port wired to a lamp or relay. We avoid 
using the term “output” for WheatNet-IP signals. While it is clear that a WheatNet-IP 
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destination wired to an output jack is an “output,” control surface fader channels would 
not normally be considered “outputs” but they are “destinations” in the WheatNet‑IP 
system, because you can route a WheatNet‑IP audio stream to them.

4. LIO. Shorthand for Logic Input or Output. In the WheatNet‑IP system, an LIO 
signal is a signal that either generates or receives logic state information created either 
physically via a logic port or virtually via some state change within a mixing control 
surface. In the WheatNet‑IP system logic information can be routed and cross con‑
nected just as audio can be.

5. GUI. Shorthand for Graphical User Interface. A method of providing for user 
interaction with the system using a special computer program that displays informa‑
tion in the form of images and text on the computer screen and accepts user input via 
typing and mouse clicking within the computer program. The WheatNet‑IP Navigator 
is a computer program that provides a GUI.

Model LIO-48 Multiple Port Logic I/O BLADE
Wheatstone’s new LIO‑48 is a high‑density logic BLADE for the WheatNet‑IP 

Intelligent Network that can handle all those new conditional logic functions needed 
for today’s busy studios. The LIO‑48 provides 48 universal logic I/O ports, each indi‑
vidually configurable, for turning devices on or off by time or event, for automatically 
adjusting the audio processing settings when a certain mic turns on, and for any other 
logic control you need in your studio operation.

 The front panel of the LIO‑48 has a logic I/O meter array that lets you drill down 
to see the information for each of the 48 ports. The front panel also sports a display 
which can show various status messages relating to the BLADE’s performance and 
configuration. A SCROLL knob, a TAKE button, and four status indicator LEDs com‑
plete the front panel. 

The rear panel has eight RJ‑45 connectors that have the connections for all 48 ports 
(each RJ‑45 has connections for six ports). Two DB‑25 female connectors duplicate 
the logic port connections. A DB‑9 female connector provides access to +5VDC from 
the BLADE. Two additional RJ‑45 connectors are stacked at the right side of the rear 
panel. The top one of there is reserved for future use, while the bottom one provides 
a 1 Gigabit connection to the WheatNet‑IP network. At the far right of the rear panel 
is a standard IFC power connector. The LIO‑48 has an internal power supply that will 
accept 100‑240 Volts 50/60 Hertz AC power.



page 1 - 5LIO-48 / May 2013

G E N E R A L  I N F O R M A T I O N

Network Switches
The next component of the WheatNet-IP system is your network switch(es). These 

are standard Ethernet devices that form the core of your LAN. You may already 
have a suitable one in place in your facility. There are literally hundreds of different 
models available in the market place which vary widely in size and capability, cost-
ing anywhere from $30 to $30,000 and up. Obviously the $30,000 switch has more 
features and capability than the $30 switch. The important thing to remember is that 
most Gigabit switches will work with WheatNet-IP – up to a point. As the size of 
your system increases, it’s easy to exceed the capability of inexpensive switches. 
Large systems need high capacity managed switches to avoid the bane of Ethernet 
audio systems, network overload. Simply put, if the WheatNet-IP devices are stream-
ing packets faster than the Ethernet switch can distribute them, packets get dropped 
and the audio starts to break up. This is why your Ethernet switches must be sized 
appropriately, and your network traffic managed and controlled so that the sizing 
assumptions you made remain valid. Because 24 bit 48K sample rate audio streams 
represent a much larger packet rate than Ethernet networks were originally assumed 
to contain, they can represent the vast majority of data in the network. Consequently 
just about any switch or link can get overloaded if you are streaming lots of channels 
and don’t attempt to manage your network and switch configuration. Conversely, 
because we use Gigabit ports for the WheatNet-IP to minimize link overload issues, 
a smaller system will run just fine on an inexpensive unmanaged switch, as long as 
it is a Gigabit switch. It’s all in the numbers.

It is important that the Ethernet network be properly set up in order for the LIO-48 
to successfully join in with the rest of the WheatNet-IP system. Network setup and 
configuration rules for the LIO‑48 are the same as those of the rest of the WheatNet‑IP 
system. Therefore we refer you to chapter three of the WheatNet‑IP Audio Over IP 
Network Technical Manual if you have any questions about the system network.

CAT-5e Wiring
The next component of your WheatNet-IP system is the CAT-5e wiring itself. 

Each “BLADE” requires a single 1 Gigabit network connection, which is typically 
a CAT-5e cable. Due to the nature of Ethernet and CAT-5e cabling, these connec-
tions must be at least 1 meter but less than 100 meters in length. If you must connect 
devices together that are more than 100 meters apart, use an interim Ethernet “edge” 
switch, or else use optical fiber and copper/fiber convertors to extend the range of 
the Ethernet LAN connections.

Software Tools
The next components of your WheatNet-IP system are the software tools used to 

administer it. While the WheatNet-IP system is completely functional (unlike some 
competitors) without running any software on a PC, you will find the Navigator GUI 
program very handy for administrating normal system functions like setting access 
passwords, controlling signal visibilities, naming sources and destinations, etc. The 
LIO‑48 also employs the Razor Setup Tool for configuration. These tools are described 
later in this manual.
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Logic Ports Connections

The rear panel has eight RJ-45 connectors that have the connections for all 48 ports 
(each RJ-45 has connections for six ports). Two DB-25 female connectors duplicate the 
logic port connections. A DB-9 female connector provides access to +5VDC from the 
BLADE.

LOGIC I/O “A” RJ-45

RJ-45 Pin 1 – Digital Ground
RJ-45 Pin 2 – Logic 1 In/Out
RJ-45 Pin 3 – Logic 2 In/Out
RJ-45 Pin 4 – Logic 3 In/Out
RJ-45 Pin 5 – Logic 4 In/Out
RJ-45 Pin 6 – Logic 5 In/Out
RJ-45 Pin 7 – Logic 6 In/Out
RJ-45 Pin 8 – +5V Digital

All “LOGIC RJ PORTS” connectors wired in same manner as the “A” connector 
shown above.

LOGIC I/O “1 - 24” DB-25

Pin 1 – Logic 1 In/Out
Pin 2 – Logic 2 In/Out
Pin 3 – Logic 3 In/Out
Pin 4 – Logic 4 In/Out
Pin 5 – Logic 5 In/Out
Pin 6 – Logic 6 In/Out
Pin 7 – Logic 7 In/Out
Pin 8 – Logic 8 In/Out
Pin 9 – Logic 9 In/Out
Pin 10 – Logic 10 In/Out
Pin 11 – Logic 11 In/Out
Pin 12 – Logic 12 In/Out
Pin 13 – Logic 13 In/Out
Pin 14 – Logic 14 In/Out
Pin 15 – Logic 15 In/Out
Pin 16 – Logic 16 In/Out
Pin 17 – Logic 17 In/Out
Pin 18 – Logic 18 In/Out
Pin 19 – Logic 19 In/Out
Pin 20 – Logic 20 In/Out
Pin 21 – Logic 21 In/Out
Pin 22 – Logic 22 In/Out
Pin 23 – Logic 23 In/Out
Pin 24 – Logic 24 In/Out
Pin 25 – Digital Ground

The “25-48” DB-25 connector wired in same manner as the “A” connector shown above.
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+5VDC LOGIC DB-9

Pin 1 – +5V Logic 1
Pin 2 – +5V Logic 2
Pin 3 – +5V Logic 3
Pin 4 – +5V Logic 4
Pin 5 – +5V Logic 5
Pin 6 – +5V Logic 6
Pin 7 – +5V Logic 7
Pin 8 – +5V Logic 8
Pin 9 – Digital Ground
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Simplified BLADE Logic I/O

Input Logic

X

1

LOGIC OUTPUT
OUTPUT

PIN
EXTERNAL

DEVICE

DGND

BLADE LIO PORT

8 +5VDC

CONTROL
START

GND

OPTO ISOLATED
EXTERNAL DEVICE

V+

START
X

OR

LOGIC OUTPUT

DGND

Output Port Specs

Sink:  • 50mA nom
 • 100mA max

X

1

LOGIC
INPUT

INPUT
PIN

EXTERNAL
CLOSURE

DGND

BLADE LIO PORT

Input Port Specs

• Internally current limited
• No pull up required

BU
U WRJ-45

LIO 1
CT7

COLOR CODES
T568A T568B

WHT/GRN WHT/ORG GNDC1
C2
C3
C4

C5
C6

C7
C8

GRN ORG LIO_RJ_1
WHT/ORG WHT/GRN LIO_RJ_2

BL LU LIO_RJ_3
WHT/BL HT/BLU LIO_RJ_4

ORG GRN LIO_RJ_5
WHT/BRN WHT/BRN LIO_RJ_6

BRN BRN LIO1 +5V
TOP

Logic Inputs are activated when the input pin is pulled to DGND.

Output Logic 

Logic Ouput ports are pulled to DGND when activated.
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NOTE: DB-25 logic connections and RJ-45 logic connections are paralleled. Either may be used.

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

LIO-48 / May 2013

LOGIC 24 IN/OUT

LOGIC 23 IN/OUT

LOGIC 21 IN/OUT

LOGIC 20 IN/OUT

LOGIC 19 IN/OUT

LOGIC 18 IN/OUT

LOGIC 17 IN/OUT

LOGIC 16 IN/OUT

LOGIC 15 IN/OUT

LOGIC 14 IN/OUT

LOGIC 13 IN/OUT

LOGIC 12 IN/OUT

LOGIC 11 IN/OUT

LOGIC 10 IN/OUT

LOGIC 9 IN/OUT

LOGIC 8 IN/OUT

LOGIC 7 IN/OUT

LOGIC 6 IN/OUT

LOGIC 5 IN/OUT

LOGIC 4 IN/OUT

LOGIC 3 IN/OUT

LOGIC 2 IN/OUT

LOGIC 1 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 22 IN/OUT

LOGIC I/O PORTS
1 - 24 DB-25

25 - 48 DB-25

LOGIC 48 IN/OUT

LOGIC 47 IN/OUT

LOGIC 45 IN/OUT

LOGIC 44 IN/OUT

LOGIC 43 IN/OUT

LOGIC 42 IN/OUT

LOGIC 41 IN/OUT

LOGIC 40 IN/OUT

LOGIC 39 IN/OUT

LOGIC 38 IN/OUT

LOGIC 37 IN/OUT

LOGIC 36 IN/OUT

LOGIC 35 IN/OUT

LOGIC 34 IN/OUT

LOGIC 33 IN/OUT

LOGIC 32 IN/OUT

LOGIC 31 IN/OUT

LOGIC 30 IN/OUT

LOGIC 29 IN/OUT

LOGIC 28 IN/OUT

LOGIC 27 IN/OUT

LOGIC 26 IN/OUT

LOGIC 25 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 46 IN/OUT

2
1

7

6

5
4

3

9
8

+5V LOGIC 5
DIGITAL GROUND

+5V LOGIC 8

+5V LOGIC 6

+5V LOGIC 4

+5V LOGIC 3

+5V LOGIC 2

+5V LOGIC 1

+5V LOGIC 7

+5VDC DB-9

1
2
3
4
5
6
7
8

A RJ-45

1
2
3
4
5
6
7
8

E RJ-45

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 25 IN/OUT
LOGIC 26 IN/OUT
LOGIC 27 IN/OUT
LOGIC 28 IN/OUT
LOGIC 29 IN/OUT
LOGIC 30 IN/OUT
+5V DIGITAL

LOGIC RJ PORTS

1
2
3
4
5
6
7
8

C RJ-45

1
2
3
4
5
6
7
8

F RJ-45

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 31 IN/OUT
LOGIC 32 IN/OUT
LOGIC 33 IN/OUT
LOGIC 34 IN/OUT
LOGIC 35 IN/OUT
LOGIC 36 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

C RJ-45

1
2
3
4
5
6
7
8

G RJ-45

DIGITAL GROUND
LOGIC 13 IN/OUT
LOGIC 14 IN/OUT
LOGIC 15 IN/OUT
LOGIC 16 IN/OUT
LOGIC 17 IN/OUT
LOGIC 18 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 37 IN/OUT
LOGIC 38 IN/OUT
LOGIC 39 IN/OUT
LOGIC 40 IN/OUT
LOGIC 41 IN/OUT
LOGIC 42 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

D RJ-45

1
2
3
4
5
6
7
8

H RJ-45

DIGITAL GROUND
LOGIC 19 IN/OUT
LOGIC 20 IN/OUT
LOGIC 21 IN/OUT
LOGIC 22 IN/OUT
LOGIC 23 IN/OUT
LOGIC 24 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 43 IN/OUT
LOGIC 44 IN/OUT
LOGIC 45 IN/OUT
LOGIC 46 IN/OUT
LOGIC 47 IN/OUT
LOGIC 48 IN/OUT
+5V DIGITAL
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NOTE: DB-25 logic connections and RJ-45 logic connections are paralleled. Either may be used.

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

LIO-48 / May 2013

LOGIC 24 IN/OUT

LOGIC 23 IN/OUT

LOGIC 21 IN/OUT

LOGIC 20 IN/OUT

LOGIC 19 IN/OUT

LOGIC 18 IN/OUT

LOGIC 17 IN/OUT

LOGIC 16 IN/OUT

LOGIC 15 IN/OUT

LOGIC 14 IN/OUT

LOGIC 13 IN/OUT

LOGIC 12 IN/OUT

LOGIC 11 IN/OUT

LOGIC 10 IN/OUT

LOGIC 9 IN/OUT

LOGIC 8 IN/OUT

LOGIC 7 IN/OUT

LOGIC 6 IN/OUT

LOGIC 5 IN/OUT

LOGIC 4 IN/OUT

LOGIC 3 IN/OUT

LOGIC 2 IN/OUT

LOGIC 1 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 22 IN/OUT

LOGIC I/O PORTS
1 - 24 DB-25

25 - 48 DB-25

LOGIC 48 IN/OUT

LOGIC 47 IN/OUT

LOGIC 45 IN/OUT

LOGIC 44 IN/OUT

LOGIC 43 IN/OUT

LOGIC 42 IN/OUT

LOGIC 41 IN/OUT

LOGIC 40 IN/OUT

LOGIC 39 IN/OUT

LOGIC 38 IN/OUT

LOGIC 37 IN/OUT

LOGIC 36 IN/OUT

LOGIC 35 IN/OUT

LOGIC 34 IN/OUT

LOGIC 33 IN/OUT

LOGIC 32 IN/OUT

LOGIC 31 IN/OUT

LOGIC 30 IN/OUT

LOGIC 29 IN/OUT

LOGIC 28 IN/OUT

LOGIC 27 IN/OUT

LOGIC 26 IN/OUT

LOGIC 25 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 46 IN/OUT

2
1

7

6

5
4

3

9
8

+5V LOGIC 5
DIGITAL GROUND

+5V LOGIC 8

+5V LOGIC 6

+5V LOGIC 4

+5V LOGIC 3

+5V LOGIC 2

+5V LOGIC 1

+5V LOGIC 7

+5VDC DB-9

1
2
3
4
5
6
7
8

A RJ-45

1
2
3
4
5
6
7
8

E RJ-45

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 25 IN/OUT
LOGIC 26 IN/OUT
LOGIC 27 IN/OUT
LOGIC 28 IN/OUT
LOGIC 29 IN/OUT
LOGIC 30 IN/OUT
+5V DIGITAL

LOGIC RJ PORTS

1
2
3
4
5
6
7
8

C RJ-45

1
2
3
4
5
6
7
8

F RJ-45

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 31 IN/OUT
LOGIC 32 IN/OUT
LOGIC 33 IN/OUT
LOGIC 34 IN/OUT
LOGIC 35 IN/OUT
LOGIC 36 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

C RJ-45

1
2
3
4
5
6
7
8

G RJ-45

DIGITAL GROUND
LOGIC 13 IN/OUT
LOGIC 14 IN/OUT
LOGIC 15 IN/OUT
LOGIC 16 IN/OUT
LOGIC 17 IN/OUT
LOGIC 18 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 37 IN/OUT
LOGIC 38 IN/OUT
LOGIC 39 IN/OUT
LOGIC 40 IN/OUT
LOGIC 41 IN/OUT
LOGIC 42 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

D RJ-45

1
2
3
4
5
6
7
8

H RJ-45

DIGITAL GROUND
LOGIC 19 IN/OUT
LOGIC 20 IN/OUT
LOGIC 21 IN/OUT
LOGIC 22 IN/OUT
LOGIC 23 IN/OUT
LOGIC 24 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 43 IN/OUT
LOGIC 44 IN/OUT
LOGIC 45 IN/OUT
LOGIC 46 IN/OUT
LOGIC 47 IN/OUT
LOGIC 48 IN/OUT
+5V DIGITAL
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Front Panel Operation
First Time Power Up

With the LIO-48 disconnected from the network, apply power by connecting its AC 
power cord to the AC power source. You will see a test pattern of LEDs on the front 
panel, and there will be a sequence of characters on the backlit display. The character 
sequence will eventually go away, as will the array of lit LEDs, and the display will read

while the front panel ERROR LED is lit. After a few seconds the ERROR LED will 
go out and the display will read

Front Panel Controls
There are two front panel controls that you will use whenever you need to do any 

configuring or testing from the front panel.
The SCROLL knob serves a dual purpose. It is used to scroll through menu selec-

tions and parameter choices, by rotating the knob, and in some instances it is used to 
advance through parameter fields, by pressing and releasing the knob, a process we will 
refer to by the term “dobby” in this manual. Thus, if we say at some point to dobby the 
SCROLL knob, we mean press it, then release it.

The other control is the square TAKE button. You can’t rotate this, so we will only 
tell you to press it. When we say this we also imply that, once pressed, you will release it.

Basic Network Settings
It is assumed, since the LIO-48 is not designed to be, nor expected to be used as, a 

standalone device, that you already have your WheatNet-IP Intelligent Network system 
up and running, and are now preparing to merge your LIO-48 into the system. If such 
is not the case, then you should expect at this point only to do some basic setup of the 
LIO-48. It isn’t really feasible to attempt to dive headlong into configuring the logic 
ports on the LIO-48 until you have worked out some of the details of logic interaction 
within the basic system.

The LIO-48 BLADE is going to work in conjunction with other BLADEs in the 
system. The LIO-48 must have its network settings configured for it to be a working 
part of the larger system. To this end, the LIO-48 must have its IP address, subnet 
mask, and gateway settings configured according to the rules of the system it is join-
ing.  Since all BLADEs must be on the same subnet, you will need to configure the 
LIO-48 to be compatible with the existing system. In a small system that has no need 
to be set differently than our standard defaults, your BLADEs will have IP addresses 
on the 192.168.87.xxx subnet, noting that each BLADE, and each other networked 
device in the system, will need to have a unique IP address on that subnet. In such a 
system the subnet mask is typically set to 255.255.255.0 and the gateway is set to the 
IP address of the network switch that ties the system together. This latter address is 
often (192.168.1) .1 or .2.          
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Making The Basic Network Settings
Let’s say, for our example, that the LIO-48 we are currently setting up is going to use 

an IP address of 192.168.87.236, a subnet mask of 255.255.255.0, and a gateway setting 
of 192.168.87.1. 

Now we can go to the front panel and make the settings. Turn the SCROLL knob 
until the display reads 

and press the TAKE button. Turn the SCROLL knob again until the display reads

and press TAKE again. The display will show you the current IP address of the LIO-48.  
For the sake of discussion we assume that you want a different IP address than the one 
displayed. Turn SCROLL until the display reads

and press TAKE. The display will again show the IP address, and the number represent-
ing the first octet of the IP address will have a flashing underline. If the first octet is not 
correct, rotate SCROLL until you have the correct number, in our example 192. Dobby 
the SCROLL knob to advance to the second octet of the IP address. Rotate SCROLL 
if needed to set the second octet, then dobby SCROLL to go to the third octet. Rotate 
SCROLL to change that octet if needed, then dobby SCROLL to advance to the fourth 
and final octet. Rotate SCROLL to set this octet. If you are using our example your dis-
play will now read:

Press TAKE to accept the new IP address you’ve set.
The display will now most likely read

and the entire subnet mask setting will have a flashing underline. Turn the SCROLL knob 
through the various settings that can be made, noting that many, but not all, combinations 
are possible. Since we will use the default 255.255.255.0, make sure that is the setting 
you leave it at, then press TAKE.

The display will now show you the gateway address.  The factory default setting 
would be

This, too, shows with the entire setting having a flashing underline. Turning the 
SCROLL knob will only give you potential gateway addresses that make sense with the 
already selected IP address and subnet mask settings. For our example, the default as 
shown above is good. Press TAKE. After a brief pause the display will read

for a second or two, then will change again to read
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At this point you will need to power cycle the LIO-48 to apply the new settings.  
Disconnect the AC power cord, wait 10 seconds, then reconnect the AC power to the 
unit.  Once it has come back up it will be using the new settings.

Please note that you can also make network setting changes from the Razor Setup 
Tool, which will be discussed in detail later.

Regarding The LIO-48 As Part Of A System
Up to this point the front panel controls we’ve discussed have not depended on 

the LIO-48 being connected to a WheatNet-IP system. However, the remaining front 
panel control items do require that the LIO-48 be connected to the system in order to 
work as described. The process of connecting the LIO-48 to a WheatNet-IP system 
will be described later in this manual.

BLADE Status Information
There are several pieces of BLADE status information that can be seen from the 

front panel. Rotate SCROLL until the display reads

and press TAKE.  Go ahead and use SCROLL to discover the available information.

Logic Testing – LOGIC METER ARRAY
The front panel also provides a way to observe the status of the logic ports on the 

LIO-48. First, the LOGIC METER ARRAY is an array of LED indicators that shows 
the current status of each of the 48 ports. The indicator array is grouped into eight 
sections, one for each of the eight RJ logic connectors on the back of the LIO-48. 
Within each group are six pairs of LED indicators representing the individual logic 
ports. Each pair has a green LED on the left to represent the status of the port if it is 
configured as an input, and a red LED to the right to represent the status of the port if 
it is configured as an output. If a logic port is ON, its appropriate LED indicator is lit, 
and if the port is OFF the LED is not lit.

Logic Testing – Drilling Deeper
The front panel display can show us more information about the logic ports.  Rotate 

SCROLL until the display reads

and press TAKE.  The display will now read

where the ‘x’ and ‘y’ characters are replaced with the appropriate status indicator from 
this list:

‘-’ means that the port in that position is not defined as the type of port indicated
‘0’ means that the port in that position is the type of port indicated and is OFF
‘1’ means that the port in that position is the type of port indicated and is ON
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An example can help clarify this description.  Let’s say the display reads like this:

The IN section indicates the following information about logic ports 1 – 6:
 port 1 is not an input port
 port 2 is not an input port
 port 3 is an input port and is OFF
 port 4 is an input port and is OFF
 port 5 is an input port and is ON
 port 6 is not an input port

while the OUT section indicates that
 port 1 is an output port and is ON
 port 2 is an output port and is OFF
 port 3 is not an output port
 port 4 is not an output port
 port 5 is not an output port
 port 6 is an output port and is OFF

As you continue rotating the SCROLL knob you will see status displays for the other 
five groups of ports.

Since we often are concerned more about the status of output logic ports than we 
are about input logic ports, there is a set of test displays that deal only with output port 
status. These displays otherwise function as described above for the combined input/
output testing.
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                     Front Panel Menu Diagram
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The Software Tools And 
Basic LIO-48 Setup

Software Basics
There are two basic software packages you will use when working with the LIO‑48.  

The first of these, Navigator, is a program you should already be familiar with, since it 
is heavily used in setting up and operating the WheatNet-IP system.  Installation and 
normal use of Navigator are topics that are well covered in the WheatNet-IP Audio Over 
IP Network Technical Manual, and will not be covered here.  We will discuss Navigator 
here only to the extent that it is needed for working with the LIO-48.

The second software package is the Razor Setup Tool.

Razor Setup Tool
Run the included installer file, wheatnetip_razor_setup_X.Y.Z.exe (where X, Y and 

Z are replaced by numbers representing the software version), to install the Razor Setup 
Tool.  Simply follow the installer instructions on screen; the process is a straightforward 
one.

You can launch the Razor Setup Tool from the Windows Start menu by selecting 
start>All Programs>Wheatstone>Wheatnet IP Razor>Razor GUI. You can also copy 
this shortcut to your desktop if needed.

Please note that the computer running the Razor Setup Tool must be a valid member 
of the WheatNet-IP system network in order that the tool can successfully communicate 
with the LIO-48, and the rest of the system.

Razor Setup Tool – First Launch
The first time you launch the program you will see a screen like this:
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Down the left side of the main panel are tabs for Sources and Destinations. This 
area will be discussed later.

At the right side of the program window you will see the System Info panel, con‑
taining tabs labeled Sources, Destinations, Salvos, and Blades. At the moment those 
tabs will be empty. We will deal with that shortly.

Across the bottom of the program window you will see the Devices panel. It will 
also be empty at the moment, and we will deal with it shortly as well.

If for some reason you do not see the Devices or System Info panels you can enable 
them by selecting View>Devices and View>System Info, respectively, from the Razor 
Setup Tool menu.

Adding A Device To The Devices Panel
We need to add the LIO-48 as a device before we can work with it in the Razor 

Setup Tool. Click the Add... button along the bottom of the Devices panel to bring up 
the Add Device dialog:

Give the device a convenient Name: (note that the sys‑
tem doesn’t care what name you use; it will display it 
for you so you can recognize the device, but it will not 
otherwise make use of the name). Click on the down ar‑
row at the right end of the Device Type: field and select 
Razor LIO-48. Then fill in the IP Address: field with 
the IP address of the LIO-48 you are adding. Your Add 
Device dialog should look something like this:

 Click Ok. The device now shows up on the Devices panel.
Click once on the device in the Devices panel list to highlight it. Make sure the 

Online check box has an X in it (click it once if it is empty), and then observe the lower 
right corner of the program window.  If all is well and the LIO-48 and the computer 
running the Razor Setup Tool are both on the same network, you should see a message 
indicating you are connected to the LIO-48.
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Discovering The System
Let’s turn our attention now to the System Info panel. As mentioned earlier, the first 

time you start up the Razor Setup Tool this area will be 
blank. So let’s get it to fill in.

Select WheatNet-IP System>System Scan... from the 
Razor Setup Tool menu to see this dialog:

Enter the IP address of an audio or engine BLADE 
in the system in the Host Blade IP Address: field. The 
Razor Setup Tool will query the chosen BLADE to get 
a map of the system resources. DO NOT use an LIO-48 
IP Address for this operation; it will not provide the 
needed results. Once the BLADE IP address is entered, 
click Start Scan. The data area will start to fill in and after 
a period of time will indicate the scan is done.

Click the Finish button. You will be asked if you want 
to save the system information just gathered.

It is a good idea to save this information at some point in 
time. Otherwise, every time you start the Razor Setup Tool 
you’ll need to do a scan to discover the available resources. 
On the flip side, any time you make a configuration change, 
such as adding or removing a BLADE, or changing a signal 
name, you will need to do a fresh scan, and a save, to keep 
the program’s knowledge of the system in sync with the changes. If you choose to save 
at this time, click Yes. You’ll be prompted to add an (optional) comment to the file, after 
which you’ll be presented with the usual Windows file save dialog. Once the save is 
done you’ll be able to continue. If you won’t be saving right now, click No to continue.



page  3 – 5LIO-48 / May 2013

S O F T W A R E  T O O L S  A N D  B A S I C  L I O - 4 8  S E T U P

At this point in time you can inspect the available 
resources by checking the various tabs in the System 
Info panel. We will use some of this information later.

The LIO-48 Is A 3rd Party Device
Depending on the amount of work you’ve already done with the WheatNet-IP 

system, and depending on what various components you have in your system, you 
may be familiar with the designation of 3rd party device. If not, suffice it to say that 
certain components in a WheatNet-IP system have to be added in as 3rd party devices, 
and the LIO-48 is one such device. Even though the procedure for adding 3rd party 
devices is covered in the WheatNet-IP Audio Over IP Network Technical Manual, we 
will cover it here as well.

With the Navigator application running, switch to the System 3rd Party Devices 
tab. In our example we already have a couple of devices added.

Click Add... to bring up the Add 3rd Party Device dialog.
Provide a Name: for the LIO-48. This name will appear 

next to the LIO-48 icon in the Navigator System panel. Enter 
the LIO‑48 IP Address: and use the Host Blade: drop down 
box to specify a BLADE in the system that the LIO-48 will 
communicate with to gain access to the system.  Leave the 
TCP Port: setting at its default of 60021. Click Ok.
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If all is well you will see that the LIO-48 has been added to the 3rd party device 
list, and also shows up in the System panel under the selected host BLADE.

At this point, we have done the basic setup required to make the LIO-48 be a part 
of our WheatNet-IP system. In the next chapter we’ll dive deeper and program the 
LIO-48 to do something useful.
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Drilling Deeper – 
Programming The LIO-48

Programming The LIO-48
In order to use the LIO-48 logic ports it is necessary to do some programming to 

configure the ports for the desired application. The tools, Wheatstone Navigator and the 
Razor Setup Tool, have already been introduced. The required steps will vary depending 
on the intended application.

We will introduce the various programming steps and techniques as we work through 
a couple of practical examples. Please note that you will be using both the Navigator 
program and the Razor Setup Tool as you work through an example, so be sure to keep 
track of which program is being used at any given step.

Wiring Switches And LEDs To The Logic Ports
Please take a look back at page 1 – 8 (one dash eight) of this manual and observe the 

diagrams and descriptions on that page.
If you are wiring a switch to a logic input port, all you need to do is connect the 

switch’s normally open (N.O.) contact to the port pin on the RJ connector and the switch’s 
common contact to the port connector’s DGND (digital ground) pin. The switch closure 
thus completes the connection from the port pin to ground and activates the input port.

To wire an LED indicator to an output port, wire the +5V pin on the RJ connector 
through a resistor to the anode of the LED, and wire the LED’s cathode back to the logic 
port pin. When the port is activated it completes the path between the logic pin and ground, 
effectively applying 5V in the proper polarity to the LED. The resistor is used to limit 
current. Although the logic output port can sink up to 100 mA max, typically you will 
want to keep the LED current down to a value in the 10 to 20 mA range, which would 
use a resistor with a value around 220 ohms.

The same connection rules apply to logic ports on other BLADEs in the system. Thus 
it won’t matter if you are wiring to a logic port on an LIO-48, or an IP-88a, or any other 
BLADE.

Notes Regarding The Examples
Please note as we work through the following examples that the names of BLADEs 

and signals used in the examples will almost certainly be different than those names in 
your system. It’s important to remember this as you compare your screen shots to ours.

Example 1 – Toggling An Indicator LED Remotely

Overview of Example 1

For this example, we will endeavor to light an indicator in one room by pressing a 
switch in another room. This type of action could be handy if you wanted a person at 
one location to get the attention of someone at a different physical location, but still part 
of the same WheatNet-IP system. In our case we will be wiring the switch into port 7 on 
the LIO-48, and wiring the LED into port 12 of  our system’s BLADE 3.



page  4 – 3LIO-48 / May 2013

D R I L L I N G  D E E P E R  –  P R O G R A M M I N G  T H E  L I O - 4 8

Program Logic On The Remote BLADE

We begin by creating a logic only source on BLADE 3 in Navigator. We name it 
LightA (later in this example we will create a second such logic signal and name it 
LightB), map it to LIO 2 PIN 7 on the BLADE, configure it as an output, and use the 
function named User 1. We will wire our LED indicator to logic port 12 on the BLADE.

Program Logic On The LIO-48

On the LIO-48 we will create a logic only destination named TurnItOn. In the Razor 
Setup Tool switch to the Destinations tab along the left side and click the Add... button 
to bring up the Add Signal dialog:

We will keep everything as-is on the Type Info tab except that we will change the 
Default Name: to TurnItOn. Make this change, then click the Next >> button, which will 
switch to the LIO Wire Info tab:
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Click Add... to bring up the Assign an I/O Wire to TurnItOn LIO 1 dialog.  

Click the line for Lio 2 – Pin 2 (this corresponds to logic port 7 on the LIO-48) to 
highlight it. Keep the I/O Direction at Input. Click Apply.

Click Finish. Back on the Razor Setup Tool main screen, click the Apply button 
below the Destinations tab area at the left of the window. This step is very important; 
do not skip it!

The last step in the process is to reboot the LIO-48. Remove AC power from the 
LIO-48, count to 10, then reapply power.

Once the LIO-48 is back online you will see the new destination appear on the Navi-
gator System Crosspoint tab. Since the Razor Setup Tool assigns default function names 
to signals as they are created, and since the function name assigned may not be the one 
we want, we may need to change the function name. Right-click on the TurnItOn des-
tination name on the System Crosspoint tab and select Modify Signal... from the popup 
menu to bring up the Edit Signal dialog for that destination. Switch to the LIO Info tab, 
highlight the LIO, and click the Edit button. Change the Function: to User 1 to match 
the function on the LightA signal. Click Apply. Click Close. Click Finish.

Make a crosspoint that connects TurnItOn to LightA.

Test Example 1

Pressing the switch connected to port 7 of the LIO-48 should now turn on the LED 
connected to port 12 of BLADE 3. The light should go off when the button is released.

Multiple Indicators

Let’s add a twist to this example and say that we want to use the button to signal the 
talent in Studio A when Studio A is being used, but sometimes we switch things up and 
use Studio B instead of Studio A. At those times we want to signal the talent in Studio B 
by using the same button.

We can accomplish this by creating a second logic only source for the second studio 
and control which source is connected to the destination by making a crosspoint change 
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when we want to switch studios. The crosspoint change could be programmed into 
the same salvo that is probably already in use for switching other resources between 
 Studio A and Studio B. For the purposes of this manual we will not get into programming 
salvos. To test the results of our example you can just switch the crosspoint manually.

Program More Logic On The Remote BLADE

Create another logic only source on BLADE 3 in Navigator and name it LightB, 
map it to LIO 2 PIN 6 on the BLADE, configure it as an output, and use the function 
named User 1. Wire another LED indicator to logic port 11 on the BLADE.

Testing The Modified Example

Now when you press the switch connected to port 7 of the LIO-48, the LED con-
nected to port 12 of BLADE 3 will light if there is a crosspoint between TurnItOn and 
LightA, but the LED on port 11 of BLADE 3 will light instead if there is a crosspoint 
between TurnItOn and LightB.

Beyond Example 1

The ideas in this example could be expanded upon in applications such as switching 
resources between studios, handling the logic involved in an intercom, and transmitting 
multiple relay closures to multiple studios from the rack room.

There are times when you may want to create a logic only source on the LIO-48. To 
do this you select the Sources tab in the Razor Setup Tool. Then proceed in the same 
manner as you did in creating the logic only destination.

Example 2 – Controlling A Control Surface Channel

Overview of Example 2

It’s possible to set up switches at a remote location to control the ON status of a 
control surface fader, and to reflect that status back to the remote operator via LED 
indicators. This is typically done at a microphone location in a studio, allowing the 
talent using the mic to turn their control surface fader on and off.

For our example, we’re going to use a Wheatstone GP-4 panel to perform these 
functions. If you don’t have access to a GP-4 you can use any four illuminated switches 
you have at your disposal. The GP-4 will be wired to a single RJ connector on the 
LIO-48 (in our example we will use the third RJ connector, corresponding to logic ports  
13 to 18). The ON switch and OFF switch use up two logic ports each, one for the switch 
contacts and one for the LED that lights the switch. Since the RJ connector gives us 
access to a total of six LIO-48 ports, we can use the other two ports to provide COUGH 
and TB (talkback) functions. This is very typically what a GP-4 is used for in a system.

The control surface in our example is an E-6. If you have a surface other than an 
E-6 you may need to adjust the procedure to accommodate differences in the surfaces.  
And if you don’t have a control surface in your system then skip this example.

Connecting The GP-4 To The LIO-48

The LIO-48 logic port RJ connectors have +5VDC on pin 8 and the corresponding 
ground on pin 1, with the 6 logic port connections using pins 2 to 7. The GP-4 has an 
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RJ connector that works nicely with this, so connection between the GP-4 and the 
LIO-48 can be made with a single normal (straight, pin-for-pin) CAT5 or CAT6 cable.

The main consideration is that the GP-4’s pins 2 through 7 are used for specific 
functions, and so the LIO-48 port setup must adhere to that configuration. Thus pin 2 
is for the COUGH switch, pin 3 is for the TB switch, pin 6 is for the OFF switch, and 
pin 7 is for the ON switch, while pin 4 is for the OFF switch indicator and pin 5 is for 
the ON switch indicator. The ports used for switches are configured as inputs, and the 
ports used for the indicators are configured as outputs.

Go ahead and connect the GP-4 RJ connector to the third RJ connector on the LIO-48.

Program Logic On The Remote BLADE

We need to set up the required logic on our audio source to react to logic inputs 
from the switches and generate logic outputs to control the switch LEDs wired to the 
LIO-48. This will be done in the Wheatstone Navigator program. Since we are pro-
gramming logic on an audio source, this setup will work no matter which fader the 
source is assigned to on the surface.

Note that when we set up logic on a signal we have the option of specifying, or 
mapping to, a hardware logic port that exists on the same BLADE that the signal 
lives on, or a hardware logic port that exists on a different BLADE than the one that 
the signal lives on. We can also map to Software LIOs on the BLADE that the signal 
lives on or on any other BLADE. We can also map to the hardware logic ports on any 
LIO-48 in the system.

In Navigator, find the audio source you want to interact with from among the 
sources listed across the top of the System Crosspoint tab. Make sure the source is not 
currently connected to any destination, since we can’t program logic on a signal while 
it is connected. Then right click on the source name label on the System Crosspoint 
tab and select Modify Signal... from the popup menu to summon the BLADEs Source 
Signal Wizard – Edit Signal dialog. Select the LIO Info tab on this dialog.

Click the Add button to add the first LIO to this signal. 
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In the Wire column of the Assign an LIO to ANA3-1 dialog (remember, your signal 
name is probably not going to be ANA3-1) expand the LIO-48 A LIOs item to show 
all available LIOs on the LIO-48. Again, note that your LIO-48 may not have the same 
name as our example, “LIO-48 A”.

Scroll down until you see the Wire rows that read RZR LIO 3 Pin 2 through  
RZR LIO 3 Pin 7 – these are the six logic ports on the third RJ connector on the back of 
the LIO-48. Click on the pin 2 row of this group to select the first port. Make sure the 
 Direction: is set to Input and the Function: is set to Cough. Click Apply.
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Program the remaining rows of this group, using the following for Direction: and 
Function:

• Pin 3 – Input – Talk Back
• Pin 4 – Output – Off Tally
• Pin 5 – Output – On Tally
• Pin 6 – Input – Remote Off
• Pin 7 – Input – Remote On
After programming all six pins, click Close and double check that you now see this:

Click Finish. That completes the LIO programming on the selected source signal.

Test Example 2

Connect the programmed source to a fader on your control surface. Now, pressing 
switch one (ON) should turn that fader on, and pressing switch two (OFF) should turn 
the fader off. When the fader is on switch one should be lit, and when the fader is off 
switch two should be lit. And when you turn the fader on or off at the surface the light-
ing of the switches will follow.

Additionally, if the fader is on and you press switch three (COUGH) you will see the 
ON switch on the fader go off while the OFF switch stays off. You will not, however, 
see the remote ON switch go off. And pressing switch four on the remote panel will 
force the fader into cue; but once again the remote panel lighting will not reflect this.

Although it is possible to control the illumination of buttons three and four on the 
remote panel, as well as have the remote ON reflect the COUGH state, that is beyond 
the scope of this document.

Beyond Example 2

The ideas in this example could be expanded upon in applications where control of 
a machine (CD, tape deck, cart machine, etc.) transport is needed.
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Additional 
Razor Setup Tool Details

What Else Can I Do?
We haven’t covered everything that you can do in the Razor Setup Tool. This chapter 

will go through the program’s menu structure and screen controls. Along the way we will 
uncover some other things you can do, and other ways to do things you’ve already seen.

The File Menu

Set Password...

You may not want just anyone to run the Razor Setup Tool. You can set a password 
that must be entered to use the program. Select 
File>Set Password... to bring up the dialog.

Like most any password setting dialog, you 
have to first enter the current password to prove you 
have the authority to change the password.  Then 
you enter the new password twice and click Ok. 
If you have entered the correct old password 
and enter the new password exactly the same in 
both fields, you will now have a new password 
in effect the next time you start the program. The 
correct password will need to be entered to use 
the program.

When working with the dialog, if there is no current password you would leave the 
Old Password: field blank. Similarly, if there is a current password but you want to re-
move it so no password is necessary, you would leave both New Password: and Retype 
Password: fields blank.

Exit

Like most programs that operate in the Windows O/S, you can quit the program by 
simply clicking the red X at the upper right corner of the program window. You can also 
select File>Exit from the menu.

The View Menu
The View menu gives you the opportunity to make some changes to the program’s 

appearance. If you click the View menu you will see three check boxes. The first two 
enable program panels. If a box has an X in it the corresponding panel of the program 
will be visible. The third changes the overall appearance of the program. Click the box 
to make the X disappear or reappear. 

Devices

This check box affects the visibility of the Devices panel.
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System Info

This check box affects the visibility of the System Info panel.

Stylized

The third box affects the overall appearance of the program. Try it to see the differ-
ence it makes.

The WheatNet-IP System Menu

File Open...

This menu item allows you to open a file to which you have previously saved the 
results of the System Scan. This is handy mainly if you are running the Razor Setup 
Tool on a laptop which you will take with you to different client sites having different 
system configurations. By saving the scan results to a different file for each system you 
support you can connect and make changes without having to perform a scan each time.  
Of course, if you make any changes to a system you will need to do a fresh scan anyway 
to maintain an accurate picture of the system for use in the Razor Setup Tool.

If you are only working with one system the Razor Setup Tool will automatically 
load the last snapshot of the system that you saved.

File Save...

Select this menu item to save the current System Scan to a file, as described in 
 Chapter 3. Note that after doing a scan you are automatically prompted to do a save, but 
this menu option allows you to defer that operation to a later time.

System Scan...

This menu item is used to begin a System Scan, as described in Chapter 3. This is a 
necessary step to enable you to properly integrate the LIO-48 into the WheatNet-IP system.

The Hardware Menu

Add New Device...

This menu choice is an alternate way to reach the Add Device dialog. See Chapter 3 
regarding adding a device to the Devices panel.

Edit “<device name>” ...

This menu selection brings up an Edit Device dialog which is quite similar in appear-
ance to the Add Device dialog, and which allows you to edit the definition of a device 
that has already been added to the Devices panel. The same dialog can be brought up by 
clicking the Edit... button at the bottom of the Devices panel.

Remove “<device name>” ...

This selection is used if you want to remove a device definition from the Devices 
panel. You will be prompted to verify the action. Clicking Yes at that point will remove 



page  5 – 4LIO-48 / May 2013

A D D I T I O N A L  R A Z O R  S E T U P  T O O L  D E T A I L S

the device from the Devices panel, while clicking No will cancel the removal. You can 
also trigger the removal action by clicking the Remove... button at the bottom of the 
Devices panel.

Assign IP Address...

In Chapter 2 we discussed setting the network parameters of the LIO-48 from the 
unit’s front panel. Alternatively, this can be done from the Razor Setup Tool by select-
ing Hardware>Assign IP Address... from the menu. This 
brings up the IP Assignment dialog:

Fill in the MAC Address field with the LIO-48 MAC 
address as found on the device’s printed label. The MAC 
address can also be found via the front panel – see the 
Front Panel Menu Diagram at the end of Chapter 2.

Fill in a Name for the device and the desired IP  Address, 
Subnet, and Gateway settings. Click START.  The Reboot 
dialog will appear:

Click OK, then remove power from the LIO-48, count to 10, and power the LIO-48 
back up. Verify that the Requests display on the IP Assignment dialog has increased 
from 0.

Click STOP, then click the red X at the 
upper right corner of the IP Assignment 
dialog to dismiss it. The LIO-48 will now 
use the new network settings.
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Version...

If it is necessary to contact Wheatstone Customer Support in regard to the LIO-48 
you may be asked what version of software the unit is running.  You can find this out 
by selecting Hardware>Version... from the menu. Please note that the Razor Setup Tool 
must be connected to the LIO-48 to obtain the version this way. You can also obtain 
the unit’s version from the front panel – see the Front Panel Menu Diagram at the end 
of Chapter 2.  

Update...

The LIO-48’s software can be updated using the Razor Setup Tool. If the factory has 
recommended that you update the LIO-48 you will be provided with an update file. It will 
have a name similar to wheatnetip_rzr_lio_X.X.X.rbn, where the X.X.X is replaced 
with the software version information. Place this file in a convenient location on the 
computer running the Razor Setup Tool, such as the Desktop.  Select Hardware>Update... 
from the Razor Setup Tool menu. This will bring up a typical Windows file open dialog.  
Locate the update file in this dialog and click Open. A new dialog will open asking you 
to confirm the update operation. Click Yes to continue with the update, or No to can-
cel. If you clicked Yes you will see a series of progress report bars. When the update is 
complete you will be prompted to reboot the computer. Once you perform the reboot 
the LIO-48 will begin operating at the new version.

Reboot...

Selecting Hardware>Reboot... is an alternate way of rebooting the LIO-48.

The Help Menu

About...

Help>About... brings up a message that tells you the version of the Razor Setup Tool.

The Main Area Controls

Add...

If you have the Sources tab selected at the left side of the Razor Setup Tool, clicking 
the Add... button on the Sources tab allows you to add a source signal to the LIO-48. If 
you have the Destinations tab selected at the left side of the Razor Setup Tool, clicking 
the Add... button on the Destinations tab allows you to add a destination signal to the 
LIO-48.

Edit...

If you have the Sources tab selected at the left side of the Razor Setup Tool, clicking 
the Edit... button on the Sources tab allows you to edit a highlighted source signal. If you 
have the Destinations tab selected at the left side of the Razor Setup Tool, clicking the 
Edit... button on the Destinations tab allows you to edit a highlighted destination signal.
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Delete

Click the Delete button to delete a highlighted source or destination.

Apply

Clicking Apply at the bottom of the Sources / Destinations area saves any source 
or destination changes you’ve made.  If you fail to click this your changes will not be 
saved.

Cancel

Clicking Cancel at the bottom of the Sources / Destinations area cancels any source 
or destination changes you’ve made since the last time you clicked Apply.

The Devices Panel Controls

Add...

Clicking Add... at the bottom of the Devices panel brings up the dialog for adding 
a panel to the Devices list.

Edit...

Clicking Edit... at the bottom of the Devices panel brings up the dialog for editing 
a panel definition in the Devices list.

Remove

Clicking Remove at the bottom of the Devices panel brings up the dialog for remov-
ing a panel definition from the Devices list.

Online

Clicking the Online box at the bottom of the Devices panel toggles between the 
online (an X in the box) and offline (no X) modes of the Razor Setup Tool. The online 
mode must be selected in order for the Razor Setup Tool to communicate with the 
panel selected in the Devices list.
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